
Intro To Excel Spreadsheet for use in Introductory Sciences 
INTRO TO EXCEL SPREADSHEET (World Population) 

Objectives: 
 Become familiar with the Excel spreadsheet environment. (Parts 1-5) 
 Learn to create and save a worksheet. (Part 1) 
 Perform simple calculations, copy formulas, fill, and edit (part 2) 
 Relative vs fixed references (part 2) 
 Graphing Equations and Formatting text and graphs (part 2 and 3a,3b, and 3c) 
 Learn to import data into Excel spreadsheet. (part 4) [parts 4&5 are in separate document] 
 Learn to make a graph of spreadsheet data and to compare data with model.   (part 5) 
 Learn about world population (past, present, and future projections) 

 
Most of the activity will have you actually use the Excel Environment and work through examples 

but if you are completely unfamiliar with the spreadsheet concept and utility, the link below is a good 
reference.  There is some good information at this site that will not be covered very well in the rest of 
the assignment.  http://www.usd.edu/trio/tut/excel/  However if you have a little idea of what Excel is 
about you should be able to work through these activities without any trouble.  The reference above still 
might be of use to you sometime in your future 

Part 1:  Opening Excel and creating your first worksheet  
 In this section, the text that you actually type in will appear as bold faced and pressing the 
return or enter key is indicated by [R], which can usually be done with a click on the OK button in a 
dialog box or using the arrows up,  down,  right, or left. If you’re using a Mac the command key is 
typically used when the control key [Ctrl] is designated for the PC. 
 
Load the Excel program by double clicking on the Microsoft Excel icon or selecting it from programs on 
the start menu.  Ask for help if you can’t find it, or use the find file command (on start men for PC or 
Finder on Mac) to find it. 

        
   

An empty worksheet should appear on your screen.  If you are using a different version of Excel, the 
menu bar may not look exactly like the one shown below; this should not be a problem for this 
introductory tutorial. 
 

 
 
First enter some labels in cells A2-A4. 
Select cell A2 by pointing on the cell A2 and clicking once. 
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  Type in Name:  [R] 
The pointer is now in cell A3. 
  Type in Date:  [R]      and then      Type in Assignment:  [R]   for cell A4 
 
 We use the shorthand notation below for the somewhat verbose instructions above to make 
this instruction guide easier to follow. 
 A2:  Name: 
 A3:  Date:  
 A4:  Assignment: 
Note:  the return key is not explicitly included in our shorthand notation but should be pressed.   
 
You may want to change the column width if your entries are too long for the default widths.  You can 
do this by clicking on the A at the top of column A to select the whole column and then either: 
move the cursor to the line between A and B and 
click and drag the width to a new size 
Easiest way for one column. 

 
Or  go to the Format menu, click and hold with the 
mouse, drag down to column and 
select width, and change the width value to a new 
width.  Format - Column – Width box is our short 
hand in this activity. 
This is great if you want to select several columns 
at once and make them all the same width. 

 

In cells B2 - B4 enter your name, date, and "World Population I" for the assignment. 
 
For practice, save your new worksheet to your disk or to a temporary space on the hard drive using the 
File-Save As command.  To use this command, point to the File menu name in the menu bar, press and 
hold the mouse button, then drag through the items in the menu until the Save As command is 
highlighted.  Releasing the mouse button when Save As is highlighted selects this command.  This short 
hand notation File-Save As command will be used for other commands throughout this activity. 
 A dialog box will appear that has book1 highlighted. 

 Type in the name for your file.  Be 
creative, but use a name that will 
remind you what's in your file. 
 Click on the Drop Down menu and 

and navigate to the  location that 
you want to save your work.  Don’t 
forget where it is. 
 Click on the save button (or press 

return). 

 
If you save this Excel document to a removable disk you can take it with you or if you save it on the hard disk you can e-mail 
it to yourself as an attachment provided you have e-mail service and an internet connection. 

Before going to the next section quickly glance through the last page on final notes regarding Excel. 
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Part 2.  Doing simple calculations with Excel. 
 In this assignment we are going to create a table of values for  world population  from 1950 to 
2050 assuming that it obeys the theoretical logistic growth function.   

 

 
 

Here A is the population at time t, Ao is the initial population at t=0,  r  is a growth rate, and K is the 
maximum population or human carrying capacity of the Earth system. 
 
We assume that we know Ao (it’s 1950 value),  and r from measurements and will use this analytical 
model to calculate  the population for different values of time after 1950 (t=year-1950).  Later we’ll use 
this table to make a graph of the World Population (predicted from the logistic growth model) from 
1950 to 2050. 
 In cells A6 - A8 enter: 
  A6:  initial population 
  A7:  Carrying capacity 
  A8:  initial growth rate 
In cells B6 - B8 enter: 
  B6:  Ao= 
  B7:  K= 
  B8:  r = 
In cells C6 - C8 enter: 
  C6:  =2.52 
  C7:  =100 
  C8:  =10 
(the equal signs for C6, C7, & C8 are important)  These original values are Very unrealistic for the 
Earth but we’ll assume that they are okay for Planet Xox. 
Let's format the labels in cells B6-B8 to spiff up 
their appearance.  Select cells  B6 - B8 by:  
pointing on B6, pressing and holding the mouse 
button, dragging the pointer to cell B8.**  (B6 - 
B8 should now be highlighted.) 
— Select  Format-Cells- Alignment tab and 
on the horizontal drop down select right. 
— This action right justifies your labels.  
Easier yet would be to simply click on the right 

justify icon on the tool bar.    This may be 
hidden in the drop down format menu on the far 
right of the tool bar. 
  

** This action will be referred to as click on B6 
and drag to B8 or simply Select Cells B6-B8 
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 4  @ R.MacKay 2003 

The nice thing about the Excel environment is that when you set the mouse pointer on top of a 
toolbar icon a text box appears describing what that icon does.  For example, clicking the disk icon 
(third from left) gives you a quick save of your work and acts like the save-as when you are saving a 
document for the first time.      
 
Click on the box labeled [B] in the tool bar to make your labels in B6-B8 bold. [they are still selected?] 

     
Make the labels in cell A2 - A4 Bold by following the same procedure as above (select and click on [B] 

icon).  Select cells C6 - C8 and left justify these cells using the left justify icon  
 
OOPS!  We made a mistake.  We forgot to put units on the labels in cells B6 - B8.  Units are always 
very important. Although Excel can only do calculations with numerical values, indicating what units 
these values are in is important so that the numbers are useful.   No problem, we'll do it now. 
Select cell B6. 
 
Position the cursor between the o and = sign of the 
formula bar at the very top of the screen and click.  
Now type  (Billions) then [R].  This should give 
you              Po(Billions)=       in cell B6 
 

 

 
In the same way include units for  B8 (billions) and B9 (%/yr). 
 
 
Use the Format-  Cell - Number command and 
then Number, set Decimal places to 2 [R] or click 
okay to set the values of cells C6 - C8 to numbers 
with two digits to the right of the decimal point.  If 
for some reason you wanted to format the cells to 
have one (or three or whatever) digits to the left of 
the decimal place you can do that also. 

 
 
In cells B10 & C10, enter: 
 B10:  Year 
 C10:  Population (Billions) 
 

Make these labels bold and align them in the center with center alignment.  
 
Here’s a sample problem that we’ll solve using the Excel environment. 
Given that the initial 1950 population is 2.52 billion people, the human carrying capacity  of planet Xox 
is 100 billion people, and the growth rate in 10% per year, what is the Xox population in 2000? 
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Enter B11: =2000 as the year.  We will then use excel to put this value into our formula to calculated the 
population at this time.   
 
Here we show the Excel equation and then right below we show the corresponding terms of the analytic 
formula. 
 
Enter c11:     
= C$6 * EXP(C$8*0.01*($B11-1950))  /  (1+C$6*(EXP(C$8*0.01*($B11-1950))-1) / C$7)
 (again make sure to include the = sign and hit the enter key) Also you do not need to include the 
spaces. 

=     Ao    e0.01r(t-1950)      
   / [ 1 +{ Ao (e0.01r(t-1950) )      -1} / K]

* The $s in the Excel version are optional right now but leave them in because they will be very useful 
soon.  The 0.01r is needed if r is in %/year and the * is the multiply by symbol. 
 
If everything works correctly when you change B11 from 1950 to  2000 the value of C11 goes from 
 2.52 (billion) to 79.3 bilion.  (This is way too high for Earth but  it may be right for Xox.) 
 
When you change B11 from 2000 to 1980 the value of c11 becomes _____________? 
 
 The above is great because we have created a calculator that allows us to put any value of  
time into cell B11 and have Excel calculate the population of planet Xox for that year and display it in 
cell C11.  We can also change the values of Ao, K, and r by entering new values in c6, c7 , or c8.  This 
is a very handy tool for evaluating different equations.  The advantage of this over a calculator is once 
the formula is typed in correctly it can be used over and over again.  Another advantage is that if you 
type in the formula incorrectly you don’t have to start all over to fix it but can simply edit it in the 
formula bar. 
 
Part 3.  Doing multiple calculations in Excel and Graphing the results. (assumes that you’ve done part 
2) 
 
Part 3a. Making a table of values from an equation 
It gets even better!   We can use what we have to make a table of theoreticalXox world population 
from 1950 to 2050.  This will make it easy to graph our results to help us visualize the behavior of this 
equation over a large range of years. 
 
The first step is to generate a bunch of years between 1950 and 2050  that are equally spaced.   
        Enter: 
 B11:  1950   (you should change it back to1950 if you had change B11 to something else while testing ) 
 B12:  1955 
   ° 
   ° 
 B31:  2050 
 
 WAIT!! 
You can do this an easy way or a hard way. 
 
1) The hard way is to enter each number into each cell one at a time. 
2) The easy way is to enter: 
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 B11:  1950    
 B12:  = B11 + 5  
Select cells B12  through  B31 (highlight them with the mouse by clicking B12 and dragging to B31) 
Use the Edit- Fill- Down command from the Edit file menu at the top of the Worksheet 
 
Note:  You can select the Edit -Fill -Down command by going to the Edit Menu drag down to Fill and 
select Down or by pressing the [CTRL] and D keys simultaneously.  Another easy way to fill down the 
equation written in cell B12 is to type it into B12 and press [R].  Then carefully move the mouse pointer 
to the lower right corner of cell B12 and when the pointer changes to a solid pointer you can click and 
then drag it down to cell B31.  This automatically fills the cells B13 to B31 with the B12 formula.  Try it 
it’s fun. 
 
Click on cell B13 and let’s take a closer look.   
 
Notice that when we used the Edit -Fill -Down command the equation that is in cell B12 (= B11 + 5) is 
copied into cell B13 as (= B12 + 5) [the value in cell B13 is 1960 but in the formula bar at the top you 
see the actual equation].  The cell assignment is relative as the equation is copied.  Another way of 
looking at it is that the equation in B12 can be read as, add 5 to the cell above this location and make 
that the value of this cell.  In cell B12, B11 is a relative cell reference .  We will describe fixed cell 
references, which are also useful, below. 
 

 
 
Let’s enter the equation for the Xox World population for the years 1950 to 2050 km  into cells C12 
through C31.  Do this by copying (Fill Down) the formula in cell C11 to cells C12 through C31.  Select 
cells C11 - C31 and use the Edit Fill Down  command.  That's all there is to it!!  Format Cell-number 
to two decimal places in C11 to C31. 
 
Select cell C12.  Notice the $ in front of the row or column label fixes the row or column (or both) so 
that when the formula is copied the fixed cell reference does not change.  This is a fixed cell reference.  
Depending on what you want to do, both variable and fixed cell references are very useful.  The c$6 
reference will always go to row 6 of whatever column you’re in.  Whereas the $b11 reference will 
always go to column B of whatever row you’re in (the row will be relative).  Click on C12 
               In the formula bar         C12 has  
= C$6 * EXP(C$8*0.01*($B12-1950))  /  (1+C$6*(EXP(C$8*0.01*($B12-1950))-1) / C$7)  
 
Remember  C11:   
= C$6 * EXP(C$8*0.01*($B11-1950))  /  (1+C$6*(EXP(C$8*0.01*($B11-1950))-1) / C$7) 
 
 
That's all there is to it!!  For each  time value in column B a population is calculated in column C . 
(Info alert:  upper and lower case letters both work the same in  excel formula cell references). 
 
Cells C11 - C31 now contain the Xox world population for the years between 1950 to 2050. 
 
The worksheet is now in good shape. Resave it using the File Save command or by clicking on the disk 
icon of the tool bar.  You should resave your work frequently , even before the final version is 
complete.  This could save you from turning a good day into a bad day if for some reason the computer 
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crashed or (heaven forbid) the operator made a careless error. 
 
This would be a good time to use the Edit-Move or Copy Sheet-Create copy command  and then resave 
the whole worksheet again.  This will give you two sheets of what you just created so you can modify 
one of them following the instructions in Part 3b and not worry about losing what you’ve already done.  
 
 

        
Part 3b.  One of the nicest features of Excel is that you can easily make a graph of your results.  
 
To make a graph  of Xox Population (c11 - c31) on the y-axis versus time (b11-b31) on the x-axis*: 
— Select cells B11 through C31 (2 columns) 
— Click on the chart wizard icon  
* The x-axis values are always in the first column on the left
     

 
 Select XY scatter and select the type of x-y scatter plot you want (click Next) 
 Excel usually knows that you are using columns for x and y data ( click next) 
 You can enter the title and axes labels here. Click on the Legends tab and uncheck the check 

box.  Click on the other tabs to see what they can do.  You can come back here later if you want 
to change your graph a bit. ** [click Next]  
 You can save the chart as a separate page or as an object on your working spreadsheet.  The save 

as object choice keeps numerical values and the graph together which is often nice. Choose save 
as object. [click finish] 

 
**If you want to modify your graph after finishing it use Chart Options of the Chart menu.  To get the 
Chart menu you have to first finish the graph and then click somewhere on it to select the whole graph. 
 
 The chart you have created is part of the worksheet.  To select the chart itself so that you can 
modify it or print just it, mouse click anywhere in the chart.  Do this now.  If the legend box is still there 
click on it and hit the delete key.  With the whole chart selected, you can change the font size, style, etc. 
with the format menu, or you can select part of the chart to reformat only it.  Playing around in the Excel 
environment and sharing what you find out with friends is the best way to learn Excel more completely.   
  
You can move the chart window to a new position to have the table and graph both clearly visible. 
 
Locate the mouse pointer inside the chart, press and hold the mouse button, and drag the window to its 
new position.  TRY THIS! 
 
Move the chart window to the right side of the monitor screen so it and columns B and C can be seen. 
 
You can change the size of the chart window by pointing on a corner of the window and dragging this 
corner to its new position.  TRY THIS!   
 
Let's add some labels to the axes and a title to the graph.  If you already added these when you first 
made your chart follow the instructions here anyway so you will learn how to edit your titles and labels. 
 
Use the Chart Options of the Chart menu to edit or add title, legend, etc. 
 — For the x-axis label use: Year 
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— For the y-axis label use: Xox population (billions) 
 
— Make up your own title. 

 
— Play around with the other tab items in the Chart Options section to see what they can do.  

After you finish click okay. 
 

— To edit the font use for the whole graph click just inside the outside edge of the graph and 
then Selected Chart Area from Format menu. This gives you options for fonts (among 
other things).  Click on an individual axis title and then use Selected axis title from 
Format menu to change the font for only that axis. 

  
 — Click on the y-axis to select it.  With the y-axis selected, use the Format - Selected axis -

Scale  tab to set the minimum y value to 0 and the maximum to 100.0.  Doing this 
manually fixes the scale of the graph so that when you make changes in the input data the 
scale doesn't change.  This makes it easier to see exactly what changes occur in the 
graph's appearance for a given input change.  If the scale did change the true changes in 
the graph's appearance would be disguised somewhat.  In the same way change the scale 
for the x-axis to from 1950 to 2050. 

 
— Resave your worksheet by using the File -Save command.   

 
— Carefully sketch your graph of Population versus year on the axes provided below.  Label 

both axes, include units, and title the graph.  Call this graph 1 
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With the worksheet selected, change r(cell C9) from 10 to 5. 
 
Reselect the chart and sketch it on the same set of axes as above.  Use a different color or line type to 
clearly and unambiguously distinguish your two curves and use a legend to the right of your graph 
above to indicate which line is which.  Call this graph 2 
 With the worksheet selected, change r(cell C9) from 5 to 20.  Sketch this on the  same set of 
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axes and  make sure that this line is clearly labeled.  Call this graph 3 
 
Let’s  use Excel to check your answer for the sketch above and put three lines on one set of axes.  This 
is pretty easy to do.  Select cells C6 through C31 [highlight these cells], copy them with [Edit-Copy-
command]or [Ctrl][C], and then select cell D6 and paste with [Edit –Paste command]or [Ctrl][V].  
Select cell E6 and Paste again.  Because of the fixed and relative references used, X distances are always 
in column B and D*, C , and U for each column depth calculation are in either C6-C8, D6-D8, or E6-E8 
respectively. 
 Cell D11 has the formula 
= D$6 * EXP(D$8*0.01*($B11-1950))  /  (1+D$6*(EXP(D$8*0.01*($B11-1950))-1) / D$7) 
 and E11 
= E$6 * EXP(E$8*0.01*($B11-1950))  /  (1+E$6*(EXP(E$8*0.01*($B11-1950))-1) / E$7) 
 
Changing C6 –C8 to (2.52, 100, 10) will give you numbers in column C for graph 1 above  
Changing D6 –D8 to (2.52, 100, 5) will give you numbers in column D for graph 2 above  
and 
Changing E6 –E8 to (2.52, 100, 20) will give you numbers in column E for graph 3 above  
 
To add a new line to the chart, select the chart and go to Chart-Add data menu item and when asked for 
the range select D11-D31 on the worksheet by clicking and dragging with the mouse. 
 
Repeat for your third line E11-E31. 
 
Remember, you can force the x-axis to go from 1950 to 2050 second by clicking it and go to The 
Format-Selected axis-Scale command and type in the min & max values of this axis.  The same 
technique that we used before to force the y-axis to go from 0 to 100. 
 
With 3 lines on one graph you may want a legend to help identify.  Chart –Chart Options -Legend tab 
and select Add Legend.    Then name each series by Chart-Source Data-Series. 
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The smiley face was added with the drawing tool Autoshape / basic .  Can you find it on the tool bar? 
 
 By now you probably feel like you're in Excel heaven.  With this fabulous tool, the 
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spreadsheet, you can easily see what happens to the theoretical Xox population for different assumed 
growth rates.  For numerical answers to specific questions, it's sometimes easiest to read the values right 
off the worksheet.  This may involve using the scroll bars at the right side or bottom of the worksheet.  
To see how they work, 
 
 — Click below the square box in the scroll bar on the right. 
 — Next drag the square box a little to see what happens. 
 — Finally, point (and click) to the arrows at the top or bottom of the scroll bar to see how 

this works. 
 

— Play with the bottom scroll bar a little. 
 
Questions:  How does an increase in initial growth rate (r) influence: 
  The time it takes Xox to get reach its carrying capacity ? 
 
  The shape of the population curve. 
 
   
 
Graphs:  After you get your graph of population for the three initial growth rates in good shape print it 
out and turn it in. 
 
 
 
 
 
 
Use the Edit-Move or Copy Sheet-Create copy command  and then resave the whole worksheet.   This 
will give you two sheets of what you just created so you can modify one of them following the 
instructions below without losing what you just did. 
 
 
 
On your new sheet: change he formula in cell B12 to :  =B11+1 so you get a population value every 
year.  Copy this to cells B13-B31.  Now select the four columns B31 to E111 and use Edit-Fill-Down.  
Move the graph to the side for right now. 
  
Calculate the average percent change in population in Cells G12-G111, H12-H111, and I12-I111.  This 
is easy to do.  Enter cell G12:    =(c12-c11)/average(c11:c12)*100  [R] 
 
Select cells G12-I12 and Edit-Fill-Right.  Then select G12-I111 (3columns) and Edit-Fill-Down. 
In F12: =(B11+B12)/2.0  and then fill the formula down to F111.   
Why do we do this to represent the time for our average growth rate?  Graph all three columns 
G12-G31, H12-H31, and I12-I31 on the y-axis with F12-F31 on the x-axis by selecting all 4 columns 
(F12-I31) and using the chart wizard icon as before. {the x-axis is always the first column} 
 
 
One way to do this is to click on the actual curve for r=10 
And depending on your sheet name you’ll get something like this in the formula bar: 
=SERIES("r=10%",'wrldPop (3)'!$B$11:$B$31,'wrldPop (3)'!$C$11:$C$31,1) 
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Change the Bs to Fs and Cs to Gs and 11s to 12s and 31s to 111s. 
Repeat this for r=5 and r=20 curve but Use H and I respectively instead of G. 
 
Or you can start completely over and make a new graph from scratch. 
 
Graphs:  After you get your graph of population growth rate over the 100 year time span for the three 
initial growth rates in good shape print it out and turn it in. 
 
 
Questions:  For the three values of r what is the average growth rate between 1950 and 1951? How do 
they compare with the respective values of r? 
 
Change K (the carrying capacity) from 100 to 10 for all three graphs.  For the three values of r what is 
the average growth rate between 1950 and 1951?  How do they compare with the respective values of r? 
 Which is the most appropriate statement? 

A. r is the initial growth rate 
B. r is the minimum initial growth rate 
C. r is the approximate initial growth rate if the carrying capacity is much larger than the initial 

population (check this statement by using a really large value for K)
D. r is the maximum initial growth rate. 
E. Both B and C 
F. Both C and D 

 
Set K back to 100 for all three graphs. 
 
Use the Edit-Move or Copy Sheet-Create copy command  and then resave the whole worksheet.   This 
will give you two sheets of what you just created so you can modify one of them following the 
instructions below without losing what you just did. 
 
Calculate the actual yearly change in population (in Billions/yr) in Cells G12-G111, H12-H111, and 
I12-I111.  This is easy to do.  Enter cell G12:    =(c12-c11) [R] 
Fill this equation to the right to H12 and I12, and then fill it down so that G12-I111 have this 
actual yearly increase.   
 
Graphs:  After you get your graph of actual yearly population growth over the 100 year time span for 
the three initial growth rates in good shape print it out and turn it in. Make sure to change units on Y-
axis and use a scale so the curves fill up the graph area pretty well. 
 
 
Questions:  For the three values of r (5, 10, and 20 %/yr). 
Rank them in order of largest actual growth to smallest actual growth in the year for each of the years 
below. 
1960:                       1980:                  2040: 
  
For the r= 20 %/yr value.  Carefully compare the population graph with the actual population growth 
graph.  During what year is the actual population growth largest? 
 
 
Describe the relationship between the steepness of the population graph to the value of the actual 
population growth? 
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Save your work for possible future activities. 
 
 
Final Notes and miscellaneous about Excel: 
 
 [Ctrl] [Z] is the Edit-Undo command and can save you head aches when you accidentally type the 
wrong thing.   
 
Also the escape key (Esc) will get you out of a cell without making changes if you are typing something 
in and you know it’s not right. 
 
If you are in cell B12 and have typed =0.1+   you can make it =0.1+B11 by clicking on the cell B11.  
This is a bit of a time saver but this feature tends to work as it should at unexpected times and is a good 
reason to remember the esc key trick. 
 
Double clicking on a line or the background or specific text brings up dialog boxes that allow you to 
change color, font type, line thickness,….. 
 
All sorts of mathematical functions can be used click on fx tool bar item of Insert-function command to 
see what the possibilities are. 
 
An automatic Sum of values can be obtained by clicking on the S tool bar item.  Look carefully when 
using this to make sure it guessed which cells you wanted to sum correctly.  If not simple edit to the 
correct value in the formula bar. 
 
In addition to the mouse, the error keys on your key board can also help you move around within the 
spreadsheet. 
 
Good Luck and have fun. 
 
 
Save this activity so you can find it again later.  
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